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What is 'Net Pal?

'Net Pal allows you to dial your Internet service provider and connect your computer to the Internet. 'Net 
Pal works with the Dial-up Networking feature of Windows 95 and Windows 98, and the RAS feature of 
Windows NT 4.0 to make the connection and has the following features :

· Re-dials until a connection is obtained.
· Can re-dial until a specified connect speed is obtained.
· Allows dialing locations to be easily changed and edited. 
· Reconnects automatically when disconnected by the remote host.
· Automatically dials a connection whenever a winsock application requires a connection to the internet. 
· Keeps track of how much time and money you have spent on each of your connections
· Ping option can provide network activity at intervals to prevent connections being dropped.
· Runs as an icon in the taskbar tray, using minimal screen space.
· IP address is displayed when connected.



What's new in this version
For a complete release history list (including bug fixes), please check our web site at 
http://www.kburra.com/cphist.html

The following changes were made in version 1.2b of 'Net Pal:
· Added /Q command line parameter to hangup a connection and shut down 'Net Pal.

The following new features were introduced in version 1.2a of 'Net Pal:
· 'Net Pal now supports Windows NT 4.0
· 'Net Pal can prompt for the connection password before dialing the connection.
· Dialing locations can be changed and edited from within 'Net Pal.
· The actual phone number being dialed is now displayed when the connection is being established.
· The reconnect feature can be limited to certain times.
· The new /H command line parameter can be used to terminate an existing connection.

The following new features were introduced in version 1.1 of 'Net Pal:

· Net Pal can now add an icon to the task bar tray.
· A minimum connect speed can be set up for each connection.
· The log now records connect speed and the number of dial attempts for each call.
· Call times can optionally be rounded up to the next whole minute.
· The window position and state can be restored each time 'Net Pal starts up.
· A shortcut can be added to the Windows Startup folder to launch 'Net Pal automatically every time 

Windows is started.
· Dialing attempts history can now be seen while dialing a connection and when a connection is active 

by using a button (labelled “…”) on the 'Net Pal window.



The main 'Net Pal window

Click on various parts of the image below to see a description of the functions of the different components
on the main 'Net Pal window.

You can press the F1 key at any time while running 'Net Pal to get help on the current procedure.



The 'Net Pal Connect window

The 'Net Pal connect window is displayed when a connection has been established. It displays 
information such as your local IP address and the time connected.

Click on various parts of the image below to see a description of the functions of the different components
on the connect window.



Using the 'Net Pal taskbar tray icon 
'Net Pal can add an icon to the taskbar tray (in the bottom right corner of the screen) which can be used 
to control the most common 'Net Pal features. Using the taskbar icon minimizes 'Net Pal's screen usage 
and can make its usage almost transparent. To enable the taskbar tray icon set the “Add icon to taskbar 
tray” option in the Options dialog.

The icon will appear as a telephone in the taskbar tray and will appear different depending on the state of 
'Net Pal as follows:

A red icon appears when there is no active connection.
A yellow icon appears when a connection is being dialed.
A green icon appears when a connection is active.

Double clicking on the tray icon
When you double click on the tray icon, the main 'Net Pal window will be hidden if it is currently displayed,
or it will be displayed again if it is currently hidden.

The tray icon menu
Clicking on the tray icon with the right mouse button will display a pop-up menu. This menu has the 
following commands on it:

Show/Hide This option will either show or hide the main 'Net Pal window. If the 
window is displayed, clicking the minimize button on the window will 
also hide it.

Connect This option will start dialing    your connection. If you have more than 
one connection then another sub-menu will appear allowing you to 
choose which connection to dial. This option is the same as selecting 
the File | Connect command in the main 'Net Pal window.

Disconnect This option will disconnect from the currently connected remote 
computer and is the same as the File | Disconnect command in the 
main 'Net Pal window. If a connection is not active, then this option will 
be disabled.

Stop This option will stop the current dialing operation. If a connection is not 
being dialed then this option will be disabled This is the same as the 
File | Stop command in the main 'Net Pal window.

Dialing 
Location

This option will display a sub-menu containing a list of the defined 
dialing locations. You can select any of the locations to change the 
current location, or you can select the Edit Locations… option to 
change any location properties.    This is the same as the dialing 
location toolbar button .

Connect only
at <speed> 
bps or higher

This option will appear only when a connection is being dialed and only
if you have a minimum connect speed enabled for that connection. If a 
check appears next to this option then the minimum connect speed will
be used. If there is no check next to this option then any speed will be 
allowed for the connection regardless of the minimum connect speed 
setting. Selecting this option will toggle the check on and off.

Exit This option will shut down 'Net Pal. If a connection is active then it will 



be disconnected first.

About This option will display the program copyright message, version 
number and registered user information.

Minimizing the main window
When the tray icon is displayed the minimize button on the main 'Net Pal window will hide the window 
instead of minimizing it. To display the main window again you can double click on the tray icon or you 
can right click on the tray icon and select the “Show” option from the pop-up menu.

Tray icon tooltips
If you move the mouse pointer directly over the tray icon and leave it there for about ½ second then a 
tooltip will appear next to the mouse pointer. The text of the tooltip will be different depending on the 
current state of 'Net Pal.

· If 'Net Pal is not connected then the tooltip will simply display the word “Disconnected”
· If 'Net Pal is dialing a connection then the tooltip will display the name of the connection being 

dialed and the number of dialing attempts made so far (this will appear in brackets).
· If 'Net Pal is connected then the tooltip will display the name of the connection, the connection 

speed and the duration of the current call. The duration which is displayed in this tooltip is 
updated every 15 seconds.



Command line options

'Net Pal supports the following command line options:

/D This option allows a connection to be dialed immediately when 'Net Pal is started. 

The option takes the following form: 

/D:”Connection Name”

where “Connection Name” is the name of one of your dial-up networking connections. 
The double quote characters must be present.

To modify a shortcut icon so that a connection is immediately dialed when you click on 
the shortcut icon, do the following:

· Right-click on the shortcut icon and select the Properties option.
· Select the Shortcut tab.
· In the Target edit box, enter a space and the /D:”Connection Name” at the end of the

existing command text, where “Connection Name” is the name of the connection 
you want to dial.

· Select OK.

/H This option hangs up (terminates) any existing connections. When this option is used 'Net
Pal looks for any other copies of 'Net Pal running on the system and tells each of them to 
terminate any active connections. The copies of 'Net Pal will stay running after they have 
hung up their connections. This option is very useful if you create a shortcut icon 
containing the /H command line option and then assign a Shortcut Key to the shortcut. 
This will let you terminate a connection by pressing a key combination on your keyboard.

/Q This option is similar to the /H parameter above, except that in addition to hanging up 
existing connections, it causes any existing copies of 'Net Pal that are running to be shut 
down as well. Using this option you could create a shortcut icon with the /D parameter to 
start 'Net Pal and dial a connection, and then create another shortcut icon with the /H 
parameter to hang up the connection and shut down 'Net Pal. You can then use these 
two shortcut icons to start and stop 'Net Pal instead of using the 'Net Pal interface to dial 
and terminate connections.



The Connect command
Selecting the Connect command from the File menu will dial the selected connection in the Connections 
list box. You will see the status of the dialing process below the Connections list box during this process. 

When the connection is established 'Net Pal will display the Connect Window, which will display 
information about the call.

A connection can also be established by clicking on the  toolbar icon, or by double-clicking on the 
connection name in the Connections list box.



The Disconnect command

Selecting the Disconnect command from the File menu will disconnect from the currently connected 
remote computer. 

A connection can also be disconnected by clicking on the  toolbar icon. If 'Net Pal is shut down while a
connection is active, then the connection will be terminated before 'Net Pal closes.



The Stop command

The Stop command on the File menu is active only while a connection is being dialed. Selecting this 
command will cause the current dialing operation to be canceled.

The  toolbar icon can also be used to terminate a dialing operation.



The Locations menu
The Locations menu allows you to change the current dialing location, or edit dialing location properties. 

This menu can be accessed either from the  toolbar button, or from the Locations option on the 
taskbar tray icon popup menu.

Selecting this option will display a popup menu with the available dialing locations. The current location 
will have a check next to it. You can switch to any of the other dialing locations by selecting the location 
name from the menu. You can edit the dialing locations (or add new locations) by selecting the Edit 
Locations… option.

Dialing locations are maintained by Windows. They are most useful to mobile users who may be travelling
and dialing connections from different area codes. If you choose the Edit Locations menu item, then you 
will be able to set the country and area codes for any of the locations. You can also set up calling card 
properties, disable call waiting, and specify other digits which must be dialed from a particular location (for
example dialing a 9 to access an outside line).



The Options dialog

The Options dialog can be displayed by selecting the Options command from the View menu. The options
that can be set in this dialog are global, and affect all connections in 'Net Pal. The dialog contains tabbed 
pages for the following categories:

· General Options page – allows window options and the auto-dial options to be set.
· Reconnect settings    page – allows you to specify whether the connection will be automatically 

redialed if it is broken for any reason.



The General Options page

The options on this page allow you to set some general properties which affect 'Net Pal, including 
automatic redialing, and specifying how the window is displayed.

Redial Connections
Selecting this option will cause 'Net Pal to keep re-dialing your connections until a connection is made. If 
the remote computer does not answer the phone, is busy or cannot log you into it's network then the 
number will be dialed again if this option is enabled. The interval allows you to set the number of minutes
and seconds to wait before attempting to dial the remote computer again after an unsuccessful attempt. 
Some computers require an interval of 3 to 5 seconds between dialing attempts to allow dial-up 
networking and the modem time to reset.

Minimize on connect
Selecting this option will cause the 'Net Pal window to automatically minimize (shrink to a taskbar icon) 
when a connection is established. If 'Net Pal is running as a taskbar tray icon and this option is selected 
then the 'Net Pal window will be hidden (instead of minimized) when a connection is established, and it 
can be displayed again by double-clicking on the taskbar tray icon.

Copy IP to clipboard
If this option is enabled then the IP (Internet Protocol) address of your local machine will be copied to the 
clipboard when a connection is established. This allows you to paste your IP address into another 
application (such as an e-mail message) by using the clipboard.

Add icon to taskbar tray
This option will add an icon to the Windows taskbar tray (in the bottom right hand corner of the screen). 
When running 'Net Pal as an icon in the taskbar tray, 'Net Pal will behave slightly differently, but can be 
much more convenient to use and access. See the help topic Using the taskbar tray icon for more 
information on using and interacting with the 'Net Pal tray icon.

Restore window state
If this option is enabled then 'Net Pal will remember the position and state of its window whenever it is 
shut down, and it will restore the same window position and state the next time 'Net Pal is started. If the 
window is minimized when it is shut down, then it will also be minimized the next time you start 'Net Pal. If
'Net Pal is running as a taskbar tray icon, then the position and hidden/displayed state of the window will 
be restored each time 'Net Pal starts.

Run on Windows start-up
If this option is enabled then a shortcut will be added to the Windows Startup folder to automatically start 
'Net Pal whenever Windows starts. If this option is turned off, then any existing shortcut to 'Net Pal in the 
Startup folder will be removed when OK is selected to close this dialog.



The Reconnect Settings page

Enable auto reconnect
This option will cause 'Net Pal to immediately dial a connection again if you are unexpectedly 
disconnected from the remote computer for any reason. This can happen if the remote computer logs you
off for any reason or because of phone line problems.

Disable if auto-dialed
If this option is checked then the auto reconnect option will be disabled if the connection was made as a 
result of auto-dialing when another application required an internet connection. This may be required to 
prevent the connection from being constantly re-established and hence adding to your charges. This will 
most likely be useful for applications which connect to the internet at regular intervals and which may 
occur while your computer is unattended.

Delay before reconnecting
This setting allows you to specify the number of minutes and seconds to wait after being disconnected, 
before 'Net Pal will try to re-establish the connection again. This may be needed if your modem or ISP 
needs time to reset before you can establish a successful connection again.

Only reconnect between these times
This allows you to restrict the time of day when 'Net Pal will automatically reconnect if a connection is 
dropped unexpectedly. If you use this option, you must set a start and end time for which the auto-
reconnect feature will be enabled. Outside of this time span, 'Net Pal will not attempt to reconnect.



The connection properties dialog

The Connection Properties dialog can be displayed by selecting the Connection Options command from 
the Connection menu. This dialog allows options to be set for each connection you have. The dialog 
contains tabbed pages for the following categories:

· Properties page - sets user name, password and minimum connect speed for the connection.
· Usage page - sets usage tracking options for the connection.
· Ping page - sets ping options for the connection to help prevent dropped connections.



The connection properties page
The options on this page allow you to set some general properties for this connection including the user 
name, password and minimum connect speed.

User name
You can enter the user name to be used for this connection here. If you do not enter a user name in this 
edit box then the default user name from Windows dial-up networking for this connection will be used. If 
Windows does not have a default user name then you will be prompted for your user name every time 
you connect using this connection.

Password
You can enter your password to be used for this connection here. The password will not be displayed as 
you type for privacy. You must enter your password exactly the same in both edit boxes. If you do not 
enter a password here then you will prompted to enter your password every time you connect using this 
connection.

Prompt before dialing
If this option is checked then a dialog box will be displayed before the connection is dialed, prompting for 
the user name and password. If you have already entered the user name and/or password in the edit 
boxes described above, then these will appear as default values when you are prompted. This feature is 
most useful if you leave the password blank on this properties page, which will mean that you need to 
enter the password every time you connect using this connection, thus providing a measure of security.

Minimum connect speed
When this option is enabled 'Net Pal will check the connect speed as soon as a connection is established 
with the remote computer (but before the user is logged on) and if it is lower than the speed specified 
here then 'Net Pal will disconnect and re-dial again.

You should enter the desired connect speed in bits-per-second (bps). For example you could enter 28800
or 26400 as valid minimum connect speeds.

You must also enter the number of dial attempts for which to use the minimum connect speed value. For 
example, you could set this value to 5 to indicate that after 5 unsuccessful attempts to establish a 
connection, any connect speed will be allowed. If this is set to "Unlimited" then a connection will never be 
established at a lower speed than that specified.

NOTE: When a minimum connect speed is specified, there is still an option to disable the setting when 
the connection is actually dialed. This will appear as a checkbox in the 'Net Pal window and as an option 
on the taskbar tray icon menu. This allows the user complete control over how the connection is 
established.

Windows Properties
Pressing this button will display the standard Windows 95 dial-up networking (or Windows NT 4.0 RAS) 
dialog box for this connection. This allows you to set such options as the modem and server type for the 
connection directly from 'Net Pal, without having to go through the dial-up networking folder or Windows 
explorer.



The connection usage page
The options on this page allow you to set usage tracking options for this connection.

Track Usage
When this option is enabled 'Net Pal will keep track of the time and money you spend when online. 
Whenever a connection is made the length and cost of the call will be accumulated on a monthly basis, 
and you can view your usage history for the last 12 months.

Fixed Fee
If your Internet Service Provider charges a fixed fee per month, enter that amount here. 'Net Pal will factor
this amount into the monthly cost.

Free Hours
If you are granted a fixed number of hours of connect time per month free (or for your fixed monthly fee) 
then enter that number of hours here.

Hourly Charge
Enter that amount you are charged per hour of online time here. This charge will be used to calculate cost
once you have spent more time than your free hours online each month.

Billing Cycle Day
Enter the day of the month on which your Internet Service Provider bills you. 'Net Pal will roll over your 
monthly time and cost totals on this day of every month.

Round call times up to the next whole minute
If this option is enabled then the time logged for each call made will be rounded up to the next whole 
minute. This means, for example, that two calls of 20 seconds each would show up in the log as two calls 
of one minute each, for a total time of 2 minutes online. The cost would also be calculated on 1 minute of 
connect time for each of the two calls.

Log All Calls
If this item is checked then 'Net Pal will keep track of every call that is made individually. 'Net Pal will keep
track of the date, time and duration of every call that you make.



The Ping page
This page allows you to set ping options for this connection. By setting a ping option 'Net Pal will generate
activity on your connection at an interval you specify. This can prevent your Internet Service provider from
logging you off when your connection is idle for too long.

Don't Ping
Disables the Ping feature.

Ping DNS Server
Choosing this option will cause 'Net Pal to ping your DNS server at the interval you specify. 'Net Pal will 
send an echo packet to the DNS server and wait for a reply.

Interval
This option is enabled if you choose a ping option and allows you to set the interval in minutes between 
pings.

Don't ping if auto-dialed
Selecting this option will prevent 'Net Pal from performing the ping when the connection was made 
automatically as a result of another application requiring an internet connection. You may want to use this 
option if you do not want the connection to be kept alive unless you explicitly establish the connection 
through 'Net Pal yourself.

When a connection is active an icon will be displayed in the status bar to indicate whether the ping feature
is currently active or not. 

 will be displayed if the ping feature is active.
 will be displayed if it is not.



The Connection Status dialog

This dialog displays usage history for the currently selected connection. If you have enabled the Track 
History options in the Connection Properties dialog, then this dialog will display the totals for (up to) the 
last 12 months.

Only 12 months of history are stored and the totals will be rolled back each new month. After 12 months 
your totals for those periods will not be available in 'Net Pal.

The list box displays the number of calls, the time spent online and the total cost for each month. The 
date displayed is the date on which the monthly period started.

To close this dialog, click the Close button or the X icon in the upper right corner of the window.

Include fixed fee
When this option is checked the fixed monthly fee for this connection will be included in the Cost column 
of the list box in this dialog. If you clear this option, then the cost displayed will not include the fixed 
monthly fee and will display the amount over the fixed fee which has been spent each month.

Clear
This button allows you to delete all of your usage history. You will be prompted to make sure you really 
want to do this, as once you clear your usage history you cannot recover it again.

Show Log >>
If you have chosen to keep a call log for this connection then this button will be enabled. This button will 
expand this dialog to display a log of all the calls you have made on this connection. The date, time, 
duration, connect speed and number of dialing attempts of each call is displayed, with the most recent 
calls displayed first. The number of dialing attempts indicates how many times the number was dialed 
before successfully establishing a connection. Once the dialog has been expanded, pressing this button 
again will hide the log and shrink the dialog again.



Toggle Auto Dial command

This command will toggle the Auto Dial feature for the currently selected connection. Only one connection
can be designated as an Auto Dial connection. The connection which is designated as the Auto Dial 
connection will be displayed with a lightning bolt icon next to it in the connections list box.

When you use the auto dial feature of 'Net Pal, 'Net Pal will load automatically and dial the selected 
connection whenever any (32 bit) application requires a connection to the internet and there is no 
currently active connection. If 'Net Pal is already loaded but is not connected then the existing instance of 
it will just dial the selected connection.

Using this feature you can set up another application (such as an e-mail program) to automatically check 
for mail at a given interval (say once an hour). Every hour when the e-mail program attempts to retrieve 
your e-mail, 'Net Pal will automatically dial your connection if there is no active connection. 

Some applications allow you to set the connection method to the internet and let you choose between 
using a dial-up networking connection or using a direct network-based connection to the internet. In these
cases, choose the direct network-based connection method. Otherwise each application will dial the 
connection independently of 'Net Pal, and the time/cost online will not be tracked by 'Net Pal.



What is Registration?
'Net Pal is a “Shareware” program. This means that you are free to use the software for up to 30 days 
free of charge for evaluation purposes. If you decide to keep the software after 30 days then you must 
register your copy with Kookaburra Software for a small fee.

The shareware (or unregistered) version of 'Net Pal contains all of the functionality of the registered 
version. This allows you to make sure that it works satisfactorily for you before you purchase the software.

When you register 'Net Pal the nag screen which is displayed when you start the program will be 
removed. In addition registration entitles you to free technical support and minor upgrades to the 
software. And don't forget that registering this and other shareware programs allows the authors to 
continue development on those and new products.

Click here to find out how to register.



How to Register 'Net Pal

The registration fee for a single copy license of 'Net Pal is US$19.

When you place an order you will receive by return e-mail or regular mail a product registration number. 
You must then enter your name and this registration number into your existing copy of 'Net Pal using the 
Registration dialog box, which is accessed by selecting the Register option from the 'Net Pal Help menu. 
You should keep your registration number safe, so that you can re-enter it if you need to re-install 
Windows or if you upgrade to a new computer at any time in the future.

 

Ordering by check
To order by check enter your order information in our Interactive Order Form and send 
the printed order form and a check to Kookaburra Software. Instructions for ordering by
check are included on the Interactive Order Form. Payment must be in US dollars 
drawn on a US bank, or you can send international postal money orders in US dollars. 
Your registration information will be sent to you via e-mail or post.
If you cannot access the order form using the above buttons, click here to view the 
form embedded in this help file.

 

Ordering by Credit Card
For information on ordering by credit card (including online ordering), click here: Credit 
Card Ordering Information. 
Your registration information will be sent to you via e-mail or post.

Site licenses
A site license for 'Net Pal entitles an organization to receive a single product registration number and use 
it to register 'Net Pal on the specified number of computers. Site license pricing is indicated below. Note 
that site licenses cannot currently be purchased when ordering through CompuServe - you must choose 
one of the other ordering methods. All prices listed are in US$.

 2 to      9 computers: $17 each
10 to 24 computers: $15 each
25 to 49 computers: $13 each
50 to 99 computers: $11 each

100 or more computers: $9 each 



Credit Card Ordering

 

The easiest way to order 'Net Pal is to order online using the secure order form at 
our Web site. To do this, just go to our Web site at http://www.kburra.com and follow 
the links for online ordering. Online orders are handled by Maagnum Commerce. 
Once your order is verified you will immediately be sent a registration notice by e-
mail which allows you to unlock your copy of 'Net Pal.

You can also order with MasterCard, Visa, American Express, or Discover through PsL. 

Note that credit card orders are taken through PsL, an independent company which 
provides a credit card ordering service only - if you have any questions regarding the 
status of your order after it has been placed with PsL, please contact Kookaburra 
Software directly. The best way to contact us for order status information is to send e-
mail to orders@kburra.com. For other inquiries regarding 'Net Pal please send e-mail to 
support@kburra.com 

The best ways to reach PsL are:

Phone: PsL's operators are available from 8:00 a.m. to 6:00 p.m. CST Monday-
Friday at the following numbers: 

800-242-4775 Ext.14948 
713-524-6394 Ext.14948

FAX: To 713-524-6398.    You can use the order form below. Please be sure to ask 
for product #14948 and please type or block print very plainly.

 

Email: To PsL at 14948@pslweb.com

Mail credit card orders to PsL at P.O.Box 35705, Houston, TX 77235-5705.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.

CONTACT KOOKABURRA SOFTWARE DIRECTLY FOR ALL OTHER SUPPORT OR INFORMATION
REQUESTS.

When you contact PsL they will require the following information:

Product Name: 'Net Pal
Product ID: 14948
Your Name: ______________________________________

Company: ______________________________________

Your E-Mail Address: ______________________________________

Credit Card [ ] MasterCard      [ ] VISA      [ ] AMEX      [ ] Discover



Credit Card Number: ______________________________________ 

Expiration Date: ______________________________________ 

Name On Card: ______________________________________ 

Billing Address: ______________________________________ 

______________________________________ 

Qty. Required: ________

Please ensure that the credit card number and expiration date are provided and are written clearly 
if ordering by fax or mail.
                                                                                                                  
Any questions about the status of the shipment of the order, registration options, product details, technical
support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be directed to 
Kookaburra Software, P.O. Box 23200. PMB 394, San Jose, CA 95153 or by internet e-mail to 
orders@kburra.com.

PsL will notify us the day that they receive your order and we will send your registration number to you.



'Net Pal Order Form
Try using the Interactive Order Form which lets you type in your order details and which will then print the 
completed order form for you. Only use the form on this page if you cannot access the order entry 
program.

This order form is for ordering by check or money order only.

To print this order form click the Print button above or select the Print Topic option on the File pull-down 
menu.

These prices are guaranteed through December, 1999. An up-to-date version of 'Net Pal can be obtained 
from the Kookaburra Software web-site at www.kburra.com. 

Send this order form to: Kookaburra Software
P.O. Box 23200. PMB 394
San Jose,    CA      95153
U.S.A.

Please check our web site at 
http://www.kburra.com/order.html 
to ensure this address is still current 
before mailing orders.

Name: _______________________________________________

Company: _______________________________________________

Address: _______________________________________________

City: _______________________________________________

State/Province: _______________________________________________

Zip/Post Code: ____________________      Country: __________________

Phone: (daytime) _______________ (evening)________________

E-Mail Address: _______________________________________________

Order Information

'Net Pal Single Copy License
I would like to register _______ copies of 'Net Pal at $19 each = _______

'Net Pal Site License - For companies or organizations
2 to      9 computers: _______ Computers at $17 each = _______
10 to 24 computers: _______ Computers at $15 each = _______
25 to 49 computers: _______ Computers at $13 each = _______
50 to 99 computers: _______ Computers at $11 each = _______

100 or more computers: _______ Computers at $9 each = _______

Total payment enclosed: $ _______

Payment must be in US dollars drawn on a US bank, or you can send international postal money orders 
in US dollars. Make checks payable to Kookaburra Software.

How did you hear about 'Net Pal? ______________________________________

Comments:



How to enter your registration number

You can enter your registration number (obtained by registering your copy of 'Net Pal) using the Register 
dialog. The Register dialog can be displayed by selecting the Register option from the Help menu.

Name
Enter your name as it appears on your registration notice from Kookaburra Software. You must enter you 
name exactly as it appears on this notice.

Registration Number
Enter your registration number exactly as it appears on your registration notice from Kookaburra 
Software.

Once you have entered your registration information correctly and selected OK, your copy of 'Net Pal will 
be registered. You must save your registration information (name and number) as you will need to re-
enter it if you re-install Windows or if you upgrade to a new computer.



Support options
Kookaburra Software currently provides technical support to registered users of 'Net Pal by e-mail and by 
regular postal mail only. You should always check the Kookaburra Software web-site (www.kburra.com) 
before requesting support to make sure you are using the latest version of 'Net Pal and to view any 
common support issues which may be on the web-site.

When requesting support please be sure to include the following information:

· Your name and contact information (either e-mail address (preferred) or street address for regular mail).
· What operating system are you using? For example, Windows 95, Windows NT 4.0 etc.
· What version of 'Net Pal are you using? You can select the About option from the Help menu to find the 

version of 'Net Pal you are using.
· If your copy of 'Net Pal is registered, what is your registration number? You can select the About option 

from the Help menu to find this information.
· Nature of the problem?
· Is the problem reproducible?
· If an error message was displayed, please include the full text of the error message.

Requesting support by E-Mail
Please send e-mail to support@kburra.com. Be sure to include the above information

Requesting support by regular mail
Please send mail to the following address:

Kookaburra Software
P.O. Box 23200. PMB 394
San Jose,    CA      95153
U.S.A.

Be sure to include the above information.



'Net Pal License Agreement

By installing 'Net Pal from Kookaburra Software on your computer you agree to the following terms and 
conditions:

· This product is distributed as a SHAREWARE computer software program. You may evaluate this 
product for a maximum of thirty (30) days from the time you first install it onto your computer. After this
time you must either remove this product from your computer or register the product with Kookaburra 
Software.

· This product may be installed on a single computer only and used by one person only.

· Kookaburra Software makes NO WARRANTIES regarding this product. You accept this product on an
AS IS basis. Kookaburra Software is not responsible for any damages whatsoever, including loss of 
information, interruption of business, personal injury and/or any damage or consequential damage 
without limitation, incurred before, during or after the use of our products.

· This program is owned by Kookaburra Software and is copyright protected. No program, code, part, 
image, text or sound may be copied or used in any way by the user except as detailed in this license 
agreement.

· You are permitted to make one (1) back-up copy of the registered program for your personal 
protection. 

· The shareware (unregistered) version of this product may be redistributed freely under the following 
conditions:

à The distribution format is not modified in any way from the original supplied by Kookaburra 
Software. Specifically no files may be altered, deleted or added to the distribution file(s).

à The distribution does not include a registration number.    In particular, you may not distribute 
a registered piece of software.

à No money is charged to the person receiving the software, beyond reasonable cost of 
packaging and other overhead.



The File menu displays commands which allow you to Connect to a connection, disconnect from an 
active connection, stop a dialing operation and exit the application.



The View menu displays an Options command which allows you to set global options for 'Net Pal.



The Connection menu displays commands which allow you to set properties, view status and enable or 
disable auto-dial for the selected connection.



The Help menu displays commands which allow you to view help, register your copy of 'Net Pal and 
display the About box for 'Net Pal.



The Connect button will dial and attempt to connect to the selected connection in the connections list 
box.



The Disconnect button will be enabled only when you are currently connected to a remote computer 
through one of your connections. Pressing this button will disconnect from the current connection and 
hang up the phone.



The Stop button will be enabled only when 'Net Pal is attempting to dial and connect to a connection. 
Pressing this button will stop the dialing operation and return 'Net Pal to its idle state.



The About button displays a dialog box, showing the version and copyright message for 'Net Pal. It also 
displays the name and registration number of the person who has registered this copy of 'Net Pal.



The Connections list box displays all of the dial-up networking connections which are defined on your 
system.



This little lightning bolt icon is displayed next to the connection which has been designated as the auto-
dial connection.



The status bar displays context sensitive information for 'Net Pal. For example, when you select a menu 
item, a description of the menu item will be displayed in the status bar.



This field displays the name of the dial-up networking connection which you are currently connected to.



This field displays the speed at which your modem is connected to the remote computer. The speed is 
displayed as the number of bits per second (bps).



This field displays the Internet Protocol (IP) address of your machine while it is connected to the internet. 
If your Internet Service provider assigns you a dynamic IP address, then this will be different every time 
you connect to the internet. You can set an option to copy your IP address to the clipboard when you 
connect, if you desire.



The field displays the host name of the computer you are connected to.



This field displays the length of time you have been connected for the current call.



This field displays the cost of the current call. This field is only displayed if you select the Track Usage 
option in the properties for this connection.



This field displays the total time you have spent online for this connection for the current month. This 
field is only displayed if you select the Track Usage option in the properties for this connection.



This field displays the total cost for the current month for the time you have spent online with this 
connection. This field is only displayed if you select the Track Usage option in the properties for this 
connection.



This icon is displayed when you are connected. It displays as a hand if the connection was manually 
dialed, or as a lightning bolt if the connection was dialed automatically.



This icon is displayed when you are connected. It indicates that the ping feature is currently active. If the 
ping is incactive then this icon will be displayed instead: 



The clock appears when 'Net Pal is dialing a connection. It simply gives confirmation that 'Net Pal is in a 
responsive state while the dialing is in progress.



This text box appears while a connection is being dialed. It displays the state of the current dialing 
operation, and the reason for failure of all previous dialing attempts. You can use the arrows on the right 
side of the text box to scroll up and down through the entries.



This check box appears when dialing a connection if a minimum connect speed has been enabled for this
connection. You can set a minimum connect speed in the connection options dialog. If there is a check in 
this box, then any connection which is made at a lower speed will immediately be terminated and dialed 
again. If this box is not checked then a connection will be allowed at any speed.



This field displays the number of times the remote computer was dialed before a successful connection 
was made.



If you press this button a dialog will be displayed which lists all attempts made to dial this connection (for 
the current call). The reason why each of the unsuccessful attempts failed will be displayed.



The Locations toolbar button displays a popup menu listing all of the dialing locations which you have 
defined. You can select any of these to change the current dialing locations, or you can select the Edit 
Locations option to edit the location settings.



Frequently Asked Questions
The items below address some questions which are commonly asked about 'Net Pal. 

The Kookaburra Software web site also has a list of Frequently Asked Questions that may be more 
current than this one. You can access this list using your web browser at http://www.kburra.com and then 
selecting the Support option.

1.       Why doesn't the Ping work properly to keep my connection alive?   
2.       Why doesn't the auto-dial feature work?   
3.       How do I install dial-up networking?   
4.       How do I uninstall 'Net Pal?   
5.       When I start 'Net Pal I receive the error message "Intl: Error initializing locale settings" one or more   

times. 
6.       When I use 'Net Pal to connect I receive an error message saying that my User name or Password   

are incorrect. 
7.       'Net Pal does not detect when my connection is dropped by my ISP.   



Why doesn't the Ping work properly to keep my connection alive?

There could be several reasons why the Ping is failing:

1. Your ISP has gotten "smart" and now recognizes automated Pings and does not treat them as 
network traffic for the purposes of keeping your connection open. We do plan on adding a "random" 
ping feature to help defeat this in a future release of 'Net Pal.

2. Your DNS address is not set up correctly, or 'Net Pal cannot find it. When 'Net Pal is running and has 
pinged at least once, display the main window and put your mouse pointer over the little star-like icon 
in the bottom right corner of the window. A tool tip should be displayed which will show the address 
and time of the last ping so you can verify if it is working or using the right address. You can check 
with your ISP to find out the DNS address that you should be using and how to enter it into your 
system.

3. The file ICMP.DLL is missing or corrupt. This file should be in your Windows System directory and if it 
is missing you may want to try to obtain it from the Windows 95 CD-ROM again.



Why doesn't the auto-dial feature work?

First, check that auto-dial is still enabled in 'Net Pal. You should see a little lightning bolt icon next to the 
connection name in the main 'Net Pal window. If you do not see this then select the Toggle AutoDial 
command from the Connection menu so that this lightning bolt icon appears.

Next, check in the Internet option in the Control Panel. If you are using Internet Explorer 4 then make sure
that the "Connect to the Internet using a local area network" option is checked. If you are using Internet 
Explorer 3 or earlier then make sure that the "Connect to the Internet as needed" option is checked.

Finally, check each of the applications you use. If they have options which allow you to select the 
connection method, then make sure that you select LAN connection or Direct Internet connection, rather 
than having the app do the dialing itself.



How do I install dial-up networking?

Microsoft has a Knowledge Base article (Q138789) which describes the process of installing and 
configuring Dial-up Networking for Windows 95 to access the Internet. Follow the link above to view this 
article. You can ignore the section of this article titled "How to Connect to Your PPP Account", as once you
have created your connection(s) you will use 'Net Pal to connect to your account(s).



How do I uninstall 'Net Pal?

You can select the “Uninstall 'Net Pal” icon from the “'Net Pal” folder in your Start Menu, or use the 
Add/Remove Programs applet in the Control Panel to remove 'Net Pal from your system.

If the uninstall program does not work for any reason, follow these steps to uninstall 'Net Pal:

· Delete all files from the directory in which you installed 'Net Pal (assuming you installed into a 
new directory). You can then remove that directory.

· Delete the file NDHOOKS.DLL from your Windows\System (or equivalent) directory.
· Delete the shortcut icons which the install program created in your Start menu.



When I start 'Net Pal I receive the error message "Intl: Error initializing locale 
settings" one or more times.

This problem was fixed in version 1.0e of 'Net Pal. Please download the current version from our Web 
Site to correct the problem.



When I use 'Net Pal to connect I receive an error message saying that my User 
name or Password are incorrect.

This problem was fixed in version 1.1a of 'Net Pal. Please download the current version from our Web 
Site to correct the problem. You will then need to go to the Connection Options screen for your connection
and either blank out or enter your password in both of the password edit boxes there to completely fix the 
problem.



'Net Pal does not detect when my connection is dropped by my ISP.

This problem is known to occur on some US Robotics Sportster 28.8 modems. When the connection is 
lost 'Net Pal does not detect that the connection is no longer active, or does not automatically reconnect 
(assuming that option is set). The problem appears to be with the US Robotics Sportster driver provided 
by Windows 95. To fix the problem, install your modem using one of the Standard Windows 95 modem 
drivers, or download an updated driver from US Robotics (download the appropriate "mdm*.inf" file from 
http://www.usr.com/home/online/files/dl07.htm.




